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1 Safety 
IMPORTANT: Please read this information BEFORE installing the equipment. 
 

1.1 Intended Users 
This manual is to be made available to all persons who are required to install, configure or service equipment 
described herein, or any other associated operation. 
The information given is intended to highlight safety issues, and to enable the user to obtain maximum benefit 
from the equipment. 
 
Complete the following table for future reference detailing how the unit is to be installed and used. 
 

INSTALLATION DETAILS 

Model Number 
(see product label) 

 

Where installed  
(for your own 
information) 

 

 
 

1.2 Application Area 
The equipment described is intended for industrial motor speed control utilizing AC induction motors or AC 
permanent magnet synchronous machines. 
 
1.3 Personnel 
Installation, operation, and maintenance of the equipment should be carried out by competent personnel. A 
competent person is someone that is technically qualified and familiar with all safety information and 
established safety practices; with the installation process, operation, and maintenance of this equipment, 
and with all the hazards involved. 
 

1.4 Product Warnings 
Special attention must be paid to the information presented in warning, caution, and information notices 
when they appear in this manual. Definitions of caution, warning and information notices are shown below: 
 

 
 
Application Risk 
 
The specifications, processes and circuitry described herein are for guidance only and may need to be 
adapted to the user’s specific application. We cannot guarantee the suitability of the equipment described in 
this Manual for individual applications. 
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Risk Assessment 
 
Under fault conditions, power loss or unintended operating conditions, the drive may not operate as 
intended. In particular: 
 

• Stored energy might not discharge to safe levels as quickly as suggested and can still be present 
even though the drive appears to be switched off. 

• The motor's direction of rotation might not be controlled 
• The motor speed might not be controlled  
• The motor might be energised 

 
A drive is a component within a drive system that may influence its operation or effects under a fault 
condition. Consideration must be given to: 

 
• Stored energy 
• Supply disconnects 
• Sequencing logic 
• Unintended operation 

 

1.5 Safety Information 
Risk of Electric Shock 
 

 

 

DANGER! 
Ignoring the following may result in injury: 

 

 
- This equipment can endanger life by exposure to rotating 

machinery and high voltages.  
- The equipment must be permanently earthed due to the high 

earth leakage current, and the inverter motor must be connected 
to an appropriate safety earth. 

- Ensure all incoming supplies are isolated before working on the 
equipment. Be aware that there may be more than one supply 
connection to the inverter. 

- There may still be dangerous voltages present at power terminals 
(motor output, supply input phases, DC bus and the brake, where 
fitted) when the motor is at standstill or is stopped. 

- For measurements use only a meter to IEC 61010 (CAT III or 
higher). Always begin using the highest range.  
CAT I and CAT II meters must not be used on this product. 

- Allow at least 5 minutes for the inverter's capacitors to discharge 
to safe voltage levels (<50V). Use the specified meter capable of 
measuring up to 1000V dc & ac rms to confirm that less than 50V 
is present between all power terminals and between power 
terminals and earth. 

- Unless otherwise stated, this product must NOT be dismantled. In 
the event of a fault the inverter must be returned. Refer to 
"Routine Maintenance and Repair". 
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Safety & EMC Requirements 
Where there is a conflict between safety and EMC requirements, personnel safety shall always take 
precedence. 
 

 

 

WARNING! 
Ignoring the following may result in injury or 

damage to equipment: 

 

 
- Never perform high voltage resistance checks on the wiring 

without first disconnecting the inverter from the circuit being 
tested. 

- Whilst ensuring ventilation is sufficient, provide guarding and /or 
additional safety systems to prevent injury or damage to 
equipment. 

- When replacing an inverter in an application and before returning 
to use, it is essential that all user defined parameters for the 
product’s operation are correctly installed. 

- When replacing an inverter in an application and before returning 
to use, it is essential that all user defined parameters for the 
product’s operation are correctly installed. 

- All control and signal terminals are SELV, i.e. protected by double 
insulation. Ensure all external wiring is rated for the highest 
system voltage. 

- Thermal sensors contained within the motor must have at least 
basic insulation. 

- All exposed metalwork in the Inverter is protected by basic 
insulation and bonded to a safety earth. 

- RCDs are not recommended for use with this product but, where 
their use is mandatory, only Type B RCDs should be used. 

 
 

 

 

WARNING! 
Ignoring the following may result in injury or 

damage to equipment: 

 

 
- In a domestic environment this product may cause radio 

interference in which case supplementary mitigation measures 
may be required. 

- This equipment contains electrostatic discharge (ESD) sensitive 
parts.  Observe static control precautions when handling, 
installing and servicing this product. 

- This is a product of the restricted sales distribution class 
according to IEC 61800-3. It is designated as “professional 
equipment” as defined in EN61000-3-2 for. Permission of the 
supply authority shall be obtained before connection to the public 
low voltage supply. 
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2 Manufacturing Location 
Germany 
Parker Hannifin Manufacturing Germany GmbH & Co. KG 
Electric Motion & Pneumatic Division (EMPD) 
Robert-Bosch-Strasse 22 
77656 Offenburg (Germany) 
Tel.: + 49 (0781) 509-0 
Website: www.parker.com/eme 
Certified according to ISO 9001:2015 
 
Parker Hannifin Manufacturing Germany GmbH & Co. KG - Sitz: Bielefeld - Amtsgericht: Bielefeld HRA 15699 
persönlich haftende Gesellschafterin: Parker Hannifin GmbH - Sitz: Bielefeld - Amtsgericht Bielefeld HRB 35489 
Geschäftsführung der Parker Hannifin GmbH: Ulrich Jochem, Achim Kohler, Andreas Paulsen, Kirsten Stenvers 
Vorsitzender des Aufsichtsrates: Dr.-Ing. Gerd Scheffel 
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3 Waste Electrical and Electronic Equipment (WEEE) 
 
 
 
Waste Electrical and Electronic Equipment - must not be disposed of with domestic 
waste. It must be separately collected according to local legislation and 
applicable laws. 
 
 
 
 
 

 

Parker Hannifin Company, together with local distributors and in accordance with EU directive 2002/96/EC, 
undertakes to withdraw and dispose of its products, fully respecting environmental considerations. 
For more information about how to recycle your Parker supplied waste equipment, please contact your local 
Parker Service Centre. 
 
Packaging 
 
During transport our products are protected by suitable packaging. This should be taken for central disposal 
as secondary raw material. 
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5 Introduction 
5.1 Product Features 

• CANopen over EtherCAT (CoE) 

• DS301 compliant 

• Ethernet RJ45 connectors 

• Network cycle time down to 100µs 

• Fast data transfer: Up to 1486 bytes of process data in each direction 

• Synchronous operation using distributed clock. 

• IIoT (Industrial Internet of Things) ready: Includes Email Client, Web server with customizable 

content, SSI (Service Side Include) functionality and FTP server 

• Ethernet Over EtherCAT (EoE).  

• File Access Over EtherCAT (FoE) 

• EtherCAT Slave Interface (ESI) files provided 

• Run and Error LEDs 

  
Note: 
The CANopen Communication Profile (DS 301) defines the basic communication mechanisms for 
exchanging data via a CANopen-based networks. This includes the structure of the object dictionary, the 
network management and boot-up as well as communication objects like PDO, SDO, SYNC and time 
stamp. 
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6 Installation 
 

 

DANGER! 
RISK OF ELECTRIC SHOCK 

 

Terminal covers, main covers, and cover fixings must remain in place 
while the drive is energized. 

These should only be removed once the supply to the unit and/or system 
has been disconnected, and the residual energy in the DC link capacitors 

has been discharged. 
 

 
 

 
CAUTION! 

ESD SENSITIVE EQUIPMENT 

 
 

Take ESD precautions when handling the Communication Interface 
Option Cards to avoid any risk of damaging the equipment. 

 
 

 
 

• All activities covered in this chapter should be carried out when there is no power to the inverter.  
• If the drive has been powered up, ensure enough time has elapsed that the inverter has discharged 

its residual energy.  
• Always check that the voltages on the user terminals are at a safe level (<50V) before carrying out 

any of these activities. 
 

6.1 Order Codes 
 

Order Code Description 

2003-CB-00 CANopen communication interface option card 

2003-EC-00 EtherCAT communication interface option card 

2003-IP-00 Ethernet IP communication interface option card 

2003-PB-00 Profibus DP-V1 communication interface option card 

2003-PN-00 PROFINET IO communication interface option card 

2003-RS-00 RS485 Modbus RTU communication interface option card 
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6.2 Fitting the Option  
Frames 2 – 5 
 
The Communication Interface Option Cards are intended to be customer installed.  
The control module housing cover will need to be removed prior to option card installation. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

1. Use a T9 TORX driver to partially unscrew the two 3x12 
countersunk fixings along the top of the product. 

2. Insert a flat head screwdriver into the moulding features and 
lever the control module housing away from the power 
t k  

3. Unhook the bottom of the control module 
housing from the power stack. 

4. Gently turn the control module upside down 
so it rests to the right of the power stack, 
with the interface cables still connected. 
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In the event that the Communication Interface Option Card needs to be removed, follow the installation 
process, but perform steps 7 and 8 in reverse.  

5. Remove and discard the Comms Option 
break-out feature in the control module 
housing by cutting the 7x bridges using 
suitable small side cutters. 

6. Remove the Comms Interface Option card from 
its packaging. 

7. Slide the Comms Card along the PCB using the 
connector features for alignment.  

Note: The front facia of the Option should be 
loose at this point. 

 

9. Now fully tighten the two T8 screws on the front 
facia of the Communication Interface Option 
Card. 

10. Check that the Option Card is secure and that it 
cannot slide out. 

11. Reassemble the product by performing the 
reverse process of steps 1 – 4. 
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Frame 6 – 10 
 
On Frames 6 – 10, the lower terminal cover will need to be removed prior to option card installation. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the event that the Communication Interface Option Card needs to be removed, perform steps 2 & 3 in 
reverse. 

1. Remove the Comms Interface Option card from its 
packaging. 

2. Slide the Comms Card along the PCB using the 
connector features for alignment.  

Note: The front facia of the Option should be loose 
at this point. 

3. When the Comms Interface Option Card is fully 
engaged in the connector and its housing has 
hocked onto the edge of the PCB, fully tighten 
the two T8 screws on the front facia. 

4. Check that the Option Card is secure and that 
it cannot slide out. 
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7 Network  
7.1 Network Connector and Cable Specification  
Two RJ45 Ethernet sockets are provided. The IN socket is connected to the master or the preceding slave 
coming from the direction of the master. The OUT socket is connected to the IN socket of the next slave, if 
there is one. The last OUT socket is Not connected 
 
Ethernet Connector (RJ45) 
 

Pin  Signal Description 

 

1 TX+ - 
2 TX- - 
3 RX+ - 
4 - Normally left unused; to ensure signal integrity, these pins are 

tied together and terminated to PE via a filter circuit in module. 5 - 
6 RX- - 
7 - Normally left unused; to ensure signal integrity, these pins are 

tied together and terminated to PE via a filter circuit in module. 8 - 

 
Cable 
 
For connecting EtherCAT devices only Ethernet cables that meet at least the requirements of category 5 
(CAT5) according to EN 50173 or ISO/IEC 11801 should be used. EtherCAT uses 4 wires for signal 
transfer.       
Only use cables terminated with RJ45 plugs. The cable length between two EtherCAT devices must not 
exceed 100m. 
. 
Wiring Example 
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7.2 LED Indications 
LED Description  

 
 

1 RUN LED 

2 ERROR LED 

3 Link/Activity (IN Port) 

4 Link/Activity (OUT Port) 

 
RUN LED 
This LED reflects the status of the EtherCAT device.   
        

LED State Description  Comments 

Off - 
No Power. 
EtherCAT device in ‘INIT’-state 

Green OPERATIONAL - 
Green, Blinking PRE-OPERATIONAL - 
Green, 1 Flash   STOPPED - 

Flickering  BOOT - 
Red EXCEPTION Fatal Event 

 
If RUN and ERR turn red, this indicates a fatal event, forcing the bus interface to a physically passive state.  
 
ERR LED 

     This LED indicates EtherCAT communication errors. 
 

LED State Description  Comments 
Off No Error No power or No Error 

Red, Blinking Invalid Configuration Invalid register or object settings 
Red, 1 flash Unsolicited state change EtherCAT state change autonomously 
Red, 2 flash Sync Manager watchdog timeout - 

Red Application controller failure Module in EXCEPTION 
Flickering Booting error detected Failure. Contact Parker technical support 

 
Link/Activity LED 
These LEDs indicate the EtherCAT link status and activity. 
 

LED Status Description  Comments 
Off No Link  Link not sensed or No power. 

Green  Link sensed No activity, no traffic detected 
Flickering Link sensed Activity, traffic detected 
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8 Configuration 
The option comms configuration is accessible through the keypad under the menu Option Comms, 
through DSE Lite function block Option Comms Config or through the webserver following the path Home 
> Engineer > Communications > Option Comms. 
The AC20 EtherCAT option requires configuration of both communication parameters and process data 
mapping. 
 

8.1 Communication parameters 
Keypad Menu Path DSE-Lite Function Block Webserver 

 

 
 

 

 

 
The network parameters of the slave must be set to establish communication with master.  

• The parameter 0691 COMMS REQUIRED must be set to EtherCAT. 
• The parameter 2566 MASTERMAPPING must be set to choose how process data mapping is 

defined. (See 8.2 Process Data for detail) 
  

Setup 

Communication 

Option 
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Configuration with DSE Lite 
When performing an online configuration, the fitted option card will automatically be selected. 
In offline mode, display your configuration page in DSE Lite and click the plus sign [+] at the left of function 
block Option Comms Config to see set communication parameters. 
 

  
 

Alternatively. perform the steps described above by double clicking on the function block Option comms 
config to open parameters tab in the configuration interface. 
 

 
 
Configuration with the webserver 
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Access the AC20 webserver by typing the IP-Address of the drive into the web browser. 
The drive must be in configuration state. Set the EtherCAT Option comms parameters as shown below. 
 
AC20 Webserver view when Master mapping is TRUE 

 

 
AC20 Webserver view when Master mapping is FALSE 
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8.2 Process Data  
AC20 parameters implementation 
The AC20 device implements CANopen over EtherCAT. The CANopen over EtherCAT (CoE) protocol 
enables the complete CANopen profile family to be utilized via EtherCAT. 
 
CANopen is object-based, meaning AC20 node has an object dictionary, which contains communication 
objects. These communication objects cover acyclic configuration data, which is handled by Service Data 
Objects (SDOs); cyclic real-time data, which is handled by Process Data Objects (PDOs). 
 
AC20 parameters can be accessed from the network via dedicated object entries in the Manufacturer 
Specific range and the Profile range (2001h - FFFFh). The SDO information protocol allows nodes to 
retrieve the name and data type of the AC20 parameters. 
 
Each object entry in the manufacturer specific objects corresponds to an AC20 parameter number, with 
parameter number 1 corresponding to object index 2001h, parameter number 2 to object index 2002h, etc. 
 
For standard parameters (of a single element), sub-index 00h of the object represents the value of the 
parameter. Its data type and access depend on the AC20 parameter.  
For multiple element parameters (parameter arrays), sub-index 00h represents the number of parameter 
elements and sub-indexes 01h-FEh represents the value of each of the parameter elements.  
 
In the example below parameter number 1 is a single element parameter and parameter number 2 is a 4-
element parameter array: 
 

AC20 Parameter number Index Subindex Description Type / Access 
1 2001h 00h Parameter Value Parameter dependent 
2 2002h 00h Number of Elements Unsigned8 / Read only 
 01h value of element 0 

Parameter dependent 
 02h value of element 1 
 03h value of element 2 
 04h value of element 3 

 
Config Mapping 
 
The AC20 EtherCAT option requires configuration of process data mapping. Parameters mapped as 
Process Data can be exchanged cyclically as Process Data Objects (PDOs) on the bus.  
 
The AC20 EtherCAT device supports up to 6 TPDOs and up to 6 RPDOs, each supporting up to 254 SDO 
(service Data Object) mappings. Each SDO equals one Process Data mapped drive parameter element.  
(See Appendix – CANopen Object Dictionary). 
 
There are two methods to define process data mapping: The process data can be mapped using the AC20 
input and output mapping tables or from the PLC.  
 
The parameter 2566 MASTERMAPPING defines the method: If FALSE the AC20 input and output mapping 
tables will be used to configure process data mapping. If TRUE, the bus master set/configures the Process 
data mapping and AC20 input and output mapping tables will be cleared. 
Note: For parameter 2566 MASTERMAPPING = ‘FALSE’: If the AC20 mapping tables are both set to 
zeros or AC20 mapping tables differs from PLC mapping then the option will be mapped from the PLC. 
  



DOC-0017-07-EN: AC20 Series - EtherCAT Option 

 DOC-0017-07-EN-B  04.04.2023  19 (58) 

Set process data using AC20 input and output mapping tables  
These tables are two parameter arrays in which AC20 parameter numbers may be added. The parameter 
2566 MASTERMAPPING must be set to FALSE. 
 
Read Mapping:  
The read process data represents cyclic data sent from the PLC to the AC20, this is mapped into the table 
Option Comms Input Mapping. Only writable AC20 parameters that are not configuration parameters may 
be added to the read process data.  

 
 

Keypad Menu Path DSE Lite Function Block Webserver 

 
 

 

 

 

Write Mapping: 
The write process data represents cyclic data sent from the AC20 to the PLC, this is mapped into the table 
Option Comms Output Mapping. 
 

 
 

Keypad Menu Path DSE Lite Function Block Webserver 

 
 
 

 
 

Note: String-type parameters cannot be mapped. 

Engineer 

Communications 

Option Comms 

Input Mapping[ ] 

Engineer 

Communications 

Option Comms 

Output Mapping[ ] 
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Set process data from EtherCAT master 
The ESI file defines the list of manufacturer specific objects. Each object corresponds to an AC20 
parameter. 
When configuring the PLC, the objects may be mapped to the process data objects (PDO) as required. 
These objects map to the process data in the order in which they are added. 
The parameter 2566 MASTERMAPPING must be set to TRUE and this will auto reset any AC20 input and 
output mapping inside the drive. 
 
Cyclic Data Exchange  
Cyclic data exchange will occur when the option is in the OPERATIONAL (PROCESS ACTIVE) or STOP 
(IDLE) state.  
However, the read process data will only update the mapped parameters when in the PROCESS ACTIVE 
state.  
On transition into the PROCESS ACTIVE state all read process mapped parameters will be updated. 
When in the PROCESS ACTIVE state, the read process mapped parameters will all update only when a 
change in the read process data occurs. 
 
Mapping status 
The process data mapping status can be accessed from AC20 via the following parameters: 

• Parameter 2586 InMappingStatus: shows the status of the currently active cyclic data input 
mapping table (32 entries), value is the Tag ID of the parameter to be cyclic read In.   

• Parameters 2619 OutMappingStatus: Shows the status of the currently active cyclic data output 
mapping table (32 entries), value is the Tag ID of the parameter to be cyclic sent out. 

The parameters 2586 InMappingStatus and 2619 OutMappingStatus are visible from webserver if 
Parameter 2566 MasterMapping = TRUE and are valid if Parameter 0774 Comms State = PROCESS 
ACTIVE. 
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8.3 Acyclic Data Exchange 
AC20 parameters may be accessed using the SDO (Service Data Object) protocol. The parameter 
numbers are mapped to the manufacturer specific range as described in the Manufacturer Specific 
Objects section. 
 
Accessing Parameters  
The value of a single-element AC20 parameter is accessed by via its corresponding object:   

index = 2000h + parameter number  
sub-index = 00h 
 

The values of a multi-element AC20 parameter are accessed via its corresponding object:  
index = 2000h + parameter number 
sub-index = element number + 1 
 

Alternatively, each element has its own parameter number and may be accessed via its corresponding 
object index.  
A string parameter array must be accessed via each element of the array. Each element has its own 
parameter number. 

 
Status Codes 
The following CANopen report codes may be reported 
 

CANopen Abort Code Description 
0602 0000h Object does not exist in the object dictionary (Parameter does not exist) 
0609 0011h Sub-index does not exist 
0601 0002h Attempt to write to read-only object 
0601 0001h Attempt to read a write-only object 
0607 0012h Data type does not match. Too much data. 
0607 0013h Data type does not match. Not enough data. 
0609 0030h Out of range. 

   

8.4 EtherCAT ESI File 
AC20 EtherCAT option is associated with an Electronic Slave Interface (ESI file) in XML format, which 
holds a description of the device and its functions.  
ESI files for the AC20 EtherCAT option may be downloaded from www.parker.com 
Some masters do not require an ESI file and can automatically extract the configuration description from 
the slave. 
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9 Example Configuration and Programming 
9.1 AC20 Motor Control Application 
Use DSE Lite to create, parameterize and configure user defined applications or parameterize and connect 
fixed motor control blocks in the application. Download the application into the drive then connect to the 
PLC to read/write the value of the parameters. 
In the example below the PLC is used to set motor speed and control, then to read the speed feedback, 
status of the control and speed reference. 
 

 
The data highlighted will be mapped into the AC20 process data mapping table in the example below. 
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9.2 List of process data   
Read / Write Process Data mapping list for master/PLC 
AC20 Input Mapping  Data Type Comments PLC Module 
1212 Input Demultiplexer 1 WORD Control Word 

Output 

2061 Input B Value Func 1 REAL Speed Setpoint 
0584 Digin Invert WORD Invert digital input 
0626 Digout Invert WORD Invert digital Output 
0497 Remote reverse BOOL Invert motor Rotation 
0498 Rem Trip Reset BOOL Trip Reset 

 
AC20 Output Mapping  Data Type Comments PLC Module 
0507 Status Word WORD Status Word 

Input 

0462 Reference REAL Speed Reference 
0103 Speed rpm REAL Speed Feedback 
0534 Anin1 Value REAL Analog In1 Value 
0540 Anin2 Value REAL Analog In2 Value 
0558 Anout1 Value REAL Analog Out1 Value 
0563 Anout2 Value REAL Analog Out2 Value 
0610 Digin Word WORD Digital Input state 
0625 Digout Word WORD Digital Output state 

 
  



DOC-0017-07-EN: AC20 Series - EtherCAT Option  

24 (58) DOC-0017-07-EN-B  04.04.2023  

9.3 Programming using Codesys platform 
The example uses Codesys V3.5 running on a PC as a soft PLC. A trial version is available to download on 
the  Codesys website. Prior knowledge of Codesys software is assumed. 
 
EtherCAT ESI File Installation 
 

• Download the AC20 EtherCAT option comms ESI file from the Parker website. 
• Start Codesys and from menu select Tools > Device Repository 
• From Device Repository tab, click on Install, Select AC20 XML device description file then click 

Add to install device into the Codesys catalog. 
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Create a project 
• Launch Codesys and select New Project from the start page. In the New Project Tab select 

project type and define properties, then click on OK.  
 

 
 
 
Select Codesys Control Win V3 as controller and select programming language, then press OK. 
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Set the Gateway 
 

Double-click the Device (Codesys Control Win V3). In device tab select Communication 
settings and click on Scan network to find the required node. From the Scan network pane click 
the required node to make it the active path. 
 

 
Note: If the node is not found, make sure the soft PLC is in “Start PLC” mode. 
 
Add EtherCAT master 
 

• Right click on Device (CoDeSys Control Win V3) open Add device Tab, select the EtherCAT 
Master and click on Add Device followed by Close. 
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• The EtherCAT Master device and an EtherCAT task will be added. Click on Browse… to find the 
target network adapter. The gateway must be active (see previous section). 

 

 
• Build and download into the Controller 
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Add AC20 EtherCAT Slave 
 
Scan for Device 

• Right-click EtherCAT Master and select Scan for Devices 
 

 
• Select device found and click on Copy All Devices to Project. 
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Add Device Manually 
 

• Right-click on EtherCAT_Master and select Add Device… Select the device 
Anybus_CompactCom_40_EtherCAT and click on Add Device and then Close. 
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Configure Process Data Mapping 
 
Option 1: Using AC20 Input and output mapping tables 
 

• The parameter 2566 MASTERMAPPING must be set to FALSE to prevent the PLC from 
overwriting the mapping. 

• Through the mapping tables from the keypad,  DSE Lite or Webserver, add parameter numbers 
into the appropriate table.    

 
Note: If the first row of a table (input mapping or Output mapping) is empty or equal to 0, the table 
will not be accessible and configurable from PLC. 

 
• From the Codesys project tree double-Click Parker_AC20_EtherCAT_Anybus_M40 to open 

device tab, select PDOs, and add process data objects. 
 

• Select “General”, then check “Expert settings” to make visible “Expert Process Data”. 

 
• Click on “Expert Process Data” to open the Tab, uncheck “PDO configuration”. 
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• Build and download the project into the PLC then go online, from slave “Expert Process Data” Tab, 

click on “Load PDO Info from The Device” to load the configured I/O mapping table into the 
project. 

 
 

• The ”Transmit PDO Mapping” now contains the objects from output mapping table of the device 
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• The ”Receive PDO Mapping” now contains the objects from output mapping table of the device 
 

 
 
 

Option 2 : From PLC 
 

• The parameter 2566 MASTERMAPPING must be set to TRUE to allow the PLC to transfer the 
mapping to the AC20. 

• In Codesys, after adding AC20 slave manually or by scanning into the project tree, double click the 
device “Parker_AC20_EtherCAT_Anybus_M40” to open the Tab. 

• Select “General”, then check “Expert settings” to make “Expert Process Data” visible. 
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• Click on “Expert Process Data” to open the pane, make sure “PDO configuration” is checked. 

 
• Select the ”Expert Process Data” pane, in ”PDO list” Pane select ”Transmit PDO Parameter” or 

”Receive PDO Parameter”, then in ”PDO Content” click ”Insert” and select items from the object 
directory in the opened tab and click OK. Repeat this task to add all parameters required. 

 
Note: The AC20 Input/Output mapping table will be set to zero and will not have effect in this 
configuration. 
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• After process data mapping configuration, compile the project then select EtherCAT I/O Mapping 
and assign a name to the variables. 
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Create a program to transfer data 
 
In the example ladder code below, in Network 1 the data is read from drive to PLC and in Network 2 the 
PLC writes data to the drive. 
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Read / Write parameters Acyclically  
 
The acyclic read / Write services can be achieved using the functions ”ETC_CO_SdoRead” and 
”ETC_CO_SdoWrite”. 

• Add function block Library: From project tree, double-click on “Library Manager”, then Click on 
“add Library” select ”EtherCATStack” Library and press OK to Add. 

 

 
 

• Example: Read parameter 0056 Current Limit Out (2038h). 

 
 

• Example: Write parameter 0457 Motor Max Speed (21C9h). 
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9.4 Programming using TwinCAT platform 
The example uses TwinCAT 3 running on a PC as a soft PLC. Prior knowledge of TwinCAT software is 
assumed. 
 
EtherCAT ESI File Installation 
 

• Download the AC20 EtherCAT option comms ESI file from the Parker website. 
• Copy the file ESI into the folder C:\TwinCAT\3.1\Config\IO\EtherCAT.  

 
Create a project 

• Launch TwinCAT XAE from windows taskbar > Notification, then click on open a New TwinCAT 
project to create a new project. 

 

            
 
 

• Define project properties, then press OK. 
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Add EtherCAT Slave 
 

• Check the target system and the state 
• Target system should be in Config mode for system setting. 

 
 

Config Process Data Mapping 
 
Option 1: Using AC20 Input and output mapping tables 
 

• The parameter 2566 MASTERMAPPING must be set to FALSE to prevent the PLC from 
overwriting the mapping. 

• Through the mapping tables from the keypad,  DSE Lite or Webserver, add parameter numbers 
into the appropriate table.    

 
Note: If the first row of a table (input mapping or Output mapping) is empty or equal to 0, the table 
will not be accessible and configurable from PLC. 
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• In TwinCAT, right click I/O > Devices and scan the network 

 
• Select the EtherCAT port and deselect any other Ethernet ports. 

 
 

• Select YES to scan for connected EtherCAT devices. 
• Select YES to activate Free Run mode. The FREE RUN mode is useful for testing the I/O and 

therefore checking the wiring without having to need to create a PLC program. 
 

        
 

  



DOC-0017-07-EN: AC20 Series - EtherCAT Option  

40 (58) DOC-0017-07-EN-B  04.04.2023  

 
• Once the scan process has been completed, a tree structure corresponding to the order appears in 

the project under I/O / Devices. 

 
 

• If you change slave mapping table after the operation described above, you will need to click AC20 
slave in the TwinCAT I/O tree to open device tabs, click on process data, Uncheck PDO 
Configuration, then click on Load PDO info from device to load the updated mapping table into 
the project.  
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Option 2 : From PLC 
 

• The parameter 2566 MASTERMAPPING must be set to TRUE to allow the PLC to transfer the 
mapping to the AC20. 

• In TwinCAT, from project tree right-click “I/O > Devices” and scan the network, to add EtherCAT 
master and AC20 device. 

 
• Click on Box 1 (Parker AC20 EtherCAT (Anybus M40)), select Process data, make sure PDO 

Configuration is checked. 
• In the PDO list Pane, select Transmit PDO Parameter or Receive PDO Parameter, then in PDO 

Content, right click a row and select item from object directory in the opened Tab. Click OK.  
• Repeat this task to add all parameters required. (see Codesys example above data for mapping 

table). 
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• Right click PLC 

 
 

• Add the standard PLC and define properties 

 
 

• Enter type and address of the variable (AT%I* : Input /  AT%Q: Output). Right click AC20_PLC 
Project select Add > Global Variable List… and edit variables that should be linked to the AC20 
I/O module. 
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• Right click AC20_PLC Project select Add > POU to add a ladder program, Edit program and call it 

from the main routine.  

 
• Save All and build  

 
Link AC20 I/O to the PLC 
 

• From I/O tree double-click AC20 Input or output module, select Linked to… then select the 
variable from the list: Link to the physical Input or Output module.  

 
 

• Perform the steps above for all the AC20 I/O objects. 
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Read / Write parameters Acyclically  
 
The acyclic read / Write services can be achieved using the functions FB_EcCoESdoRead and 
FB_EcCoESdoWrite. 
 

• From project tree, double-click on References to open the Library manager, then Click on add 
Library select the Tc2_EtherCAT Library and press OK to Add. 

 

 
 

• Example: Read parameter 0056 Current Limit Out (2038h). 
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• Example: Write parameter 0457 Motor Max Speed (21C9h). 

 
 

Start TwinCAT Runtime 
 

• Enable Config: Press Activate Configuration. 

 
 

• Wait and verify Run Mode 

 
 

• Build the PLC and Login 
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10 Lost Communication Trip 
Supervised Parameter: 
The 0777 Comms Supervised parameter indicates that the EtherCAT network participation is supervised 
by another EtherCAT device. 
The Supervised parameter value is set to TRUE when either:  

The heartbeat consumer and Heartbeat producer is enabled and error free. 
Node guarding is enabled and error free. 

Note that the watchdog will not be available if the Read Process data size is zero, in which case the 
Supervised parameter will be FALSE. 
 
Comms Break Trip 
The drive will trip when there is a loss of communications between the master and the drive. 
A COMMS BREAK trip will occur if the 0777 Comms Supervised parameter transitions from TRUE to 
FALSE and the drive is in the operational state. 
The trip may be disabled by clearing the respective bit in the parameter 0870 Enable Trips Lo. The 
parameter Enable Trip Lo is a 32-bit word, the bit number 27 is used to disable or to enable the trip. 
 
Comms state 
The parameter 0774 Comms State indicates ‘PROCESS_ACTIVE’ when the EtherCAT communication is 
active. The table below describes how the comms state relates to the EtherCAT network: 
 
Comms State Comments 
WAIT_PROCESS INIT, BOOTSTRAP or PRE-Operational 
IDLE SAFE-OPERATIONAL 
PROCESS_ACTIVE Operational: the network process data channel is active 
ERROR (Error Ind’-bit in ‘AL-Status’ is set) 
EXCEPTION EtherCAT interface is forced to INIT state, and the master is informed that a power 

cycle is required to resume communication 
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11 Diagnostic Event 
Configuration problems can often be identified by looking at the Run and Error LEDs and from the 
EtherCAT State and Comms Diagnostic 0775 parameters. Under normal operating conditions the Comms 
diagnostic parameter should indicate OK. Other values are summarized in the Diagnostic Parameters 
section. 

 
Hardware Mismatch  

Diagnostic = HARDWARE MISMATCH: 
The required option does not match the actual fitted option.  
No option is fitted but one is required. 

 
Invalid Configuration  

Diagnostic = INVALID CONFIGURATION: 
Invalid read or write process data mapping 
Invalid communication settings  

 
Diagnostic = MAPPING FAILED: 

Attempting to map a parameter that does not exist. 
Attempting to map a configuration parameter.  
Attempting to map a read-only parameter to the read process data.  

 
Other Diagnostics 

Diagnostic = EXCEPTION : 
Module has gone into an unrecoverable exception state 
 
Diagnostic = UNSUPPORTED OPTION: 
The fitted option is not supported by the drive 
 
Diagnostic = NOT RESPONDING: 
no initial response from the option 

 
When a diagnostic event is entered a new entry is created in object entry 1003h (pre-defined error field) 
The Error Register (object 1001h) is set with the corresponding bit information. 
 

High Byte Low Byte 
Not used Not used Event Code 00h 

 
The EMCY Object is sent to the network with the following information:   
 
Byte 0            Byte 1              Byte 2                                  Byte 3                                                           

Byte7 
00h Event Code Event Register (1001h) Not used 

 
EMCY Error 
Code 

Description 

8110h CAN controller signaled a lost message 
8120h CAN controller reached the warning limit due to error frames. 
8210h A received PDO was smaller than specified by the valid mapping table 
8220h The DLC of a received PDO exceeded the length specified by the mapping table. 
8130h An error control event has occurred (either a life guarding or heartbeat event). 
8140h CAN controller has recovered from a BUS OFF state. 
8150h COB-ID collision detected. 
FF01h Process data remap was NAKed by the host application. No valid process data map 

available. 
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APPENDIX A: Data types 
The relationship between AC20 parameter and CANopen data type is given in the table below. 
 

AC20 Parameter  CIP    
Data Type  Description  Data Type  Bytes  
BOOL  Boolean  BOOL  1  
SINT  Short integer  SINT  1  
INT  Integer  INT  2  
DINT  Double integer  DINT  4  
USINT  Unsigned short integer  USINT  1  
UINT  Unsigned integer  UINT  2  
UDINT Unsigned double integer UDINT  4  
REAL  Floating point  FLOAT  4  
TIME  Duration  UDINT  4  
DATE  Date  UDINT  4  
TIME_OF_DAY  Time of day  UDINT  4  
DATE_AND_TIME  Date and time of day  UDINT  4  
STRING  String  SHORT_STRING**  n  
BYTE  Bit string length 8  USINT  1  
WORD  Bit string length 16  UINT  2  
DWORD  Bit string length 32  UDINT  4  

 
Arrays 
Some parameters have multiple elements and are classified as parameter arrays.  A parameter array has a 
parameter number that accesses the whole of the array.  It also has parameter numbers that represent 
each element of the array.  
    
Array Example: A parameter array called VHZ_USER FREQ has 11 elements.    

Parameter Number   Parameter - VHZ_USER FREQ 
0145  whole array  
0146 index 0  
0147 index 1  
…  … 
0157 index 10  

  
If the parameter number of the whole array is 0145, then the parameter number of the element index 0 of 
the array will be 0134, the parameter number of the element index 01 will be 0147, etc.  
 
String  
A string parameter may be accessed via its parameter number.  
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APPENDIX B: Parameters 
Function Block Inputs 

Parameter Name No. Default Value Range Units Type Writable 
COMMS REQUIRED 691 1: None 0: Unknown  

1: None  
2: CANopen  
3: EtherCAT  
4: Ethernet IP  
5: Modbus RTU  
6: Profibus  
7: Profinet 

 ENUM CONFIG 

Communications option required. 
ADDR ASSIGNMENT 758 0: External 0: External  

1: Fixed  
2: DHCP 

 ENUM CONFIG 

Method for assigning the IP address. 
SET IP ADDRESS 759 0   ADDR CONFIG 
Ethernet option IP address 
SET SUBNET MASK 760 0   ADDR CONFIG 
Ethernet option subnet mask. 
SET GATEWAY ADDR 761 0   ADDR CONFIG 
Ethernet option gateway address. 
ACCESS 762 31: 31 0: IP Config Enable  

1: Web Enable  
2: Web Parameters Enable  
3: FTP Enable  
4: FTP Admin Mode   

 WORD CONFIG 

Ethernet access using comms option (bitwise) 
NODE ADDRESS 763 0   USINT CONFIG 
Communications node address. 
CANOPEN BAUD 764 9: Auto 0: 10 kbps  

1: 20 kbps  
2: 50 kbps  
3: 100 kbps  
4: 125 kbps  
5: 250 kbps  
6: 500 kbps  
7: 800 kbps  
8: 1000 kbps  
9: Auto  
10: Lss 

 ENUM CONFIG 

Required baud Rate for CANopen. 
MODBUS BAUD RATE 765 4: 19200 BPS 0: 1200 bps  

1: 2400 bps  
2: 4800 bps  
3: 9600 bps  
4: 19200 bps  
5: 38400 bps  
6: 57600 bps  
7: 76800 bps  
8: 115200 bps 

 ENUM CONFIG 

Required baud Rate for Modbus RTU 
PARITY 766 0: Even 1 Stop 0: Even 1 Stop  

1: Odd 1 Stop  
2: None 2 Stop  
3: None 1 Stop 

 ENUM CONFIG 

Modbus parity and stop bits 
HIGH WORD FIRST 767 FALSE   BOOL CONFIG 
For 32-bit values high word comes first if set to TRUE. 
ACTIVE TIMEOUT 768 0 0 to 65  TIME CONFIG 
Process active timeout period. 
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Parameter Name No. Default Value Range Units Type Writable 
MASTERMAPPING 2566 TRUE   BOOL CONFIG 
Switch to choose how the PROFInet, EtherCAT, PROFIbus and CanOpen PDO mapping is defined: If TRUE the bus master 
sets/configures the PDO mapping. The drive mapping parameters 692...757 are cleared (set to zero) and made invisible (GKP and 
website) as this the required condition. If FALSE the mapping parameters 692...757 are visible (Keypad and webserver) can be 
used to define the PDO mapping from drive side (which the bus master then can upload). The switch is considered during drive 
startup (stopped -> operational transition). 

 
Function Block Outputs 

Parameter Name No. Default Value Range Units Type Writable 
COMMS FITTED 769 0: Unknown 0: Unknown  

1: None  
2: CANopen  
3: EtherCAT  
4: Ethernet IP  
5: Modbus RTU  
6: Profibus  
7: Profinet 

 ENUM NOT 

Communications option fitted. 
COMMS VERSION[0] 770 0   USINT NOT 
Firmware version of the comms module. 
COMMS VERSION[1] 770 0   USINT NOT 
Firmware version of the comms module. 
COMMS SERIAL NUM 773 0   DWORD NOT 
Serial number of the comms module. 
COMMS STATE 774 8: None 0: Setup  

1: NW Init  
2: Wait Process  
3: Idle  
4: Process Active  
5: Error  
6: Reserved  
7: Exception  
8: None 

 ENUM NOT 

State of the option comms. 
DIAGNOSTIC 775 0: Ok 0: Ok  

1: Hardware Mismatch  
2: Invalid Configuration  
3: Mapping Failed  
4: Exception  
5: Unsupported Option  
6: Not Responding 

 ENUM NOT 

Diagnostic for the comms option. 
EXCEPTION CODE 776 0   WORD NOT 
Diagnostic code on option entering exception state. The MSB is the exception code and the LSB is the exception info. 
COMMS SUPERVISED 777 FALSE   BOOL NOT 
Indicates a master has made a connection to the device. 
MAPPING CHANGED 778 FALSE   BOOL NOT 
The PLC has changed the process data mapping from that set by the drive. 
STATION NAME 779    STRING NOT 
Current PROFINET station name. 
IP ADDRESS 787 0   ADDR NOT 
Current Ethernet option IP address. 
SUBNET MASK 788 0   ADDR NOT 
Current Ethernet option subnet mask. 
GATEWAY ADDRESS 789 0   ADDR NOT 
Current Ethernet option gateway address. 
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Parameter Name No. Default Value Range Units Type Writable 
ACTUAL BAUD RATE 790 0: 10 kbps 0: 10 kbps  

1: 20 kbps  
2: 50 kbps  
3: 100 kbps  
4: 125 kbps  
5: 250 kbps  
6: 500 kbps  
7: 800 kbps  
8: 1000 kbps  
9: Auto  
10: lss 

 ENUM NOT 

Actual CANopen baud rate. 
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APPENDIX C: DSE Lite Quick Start Guide 
Follow the steps below to configure the AC20 via DSE Lite PC-Tool. 
The block diagram of the AC20 may be accessed through the onboard webserver or DSE Lite.  
DSE Lite is recommended. 
The IP address of the AC20 is in the range 169.254.xx.xx by default. Therefore, the user’s PC network 
adapter must be configured to this range as shown below (IPv4 is used for communication). 
 

         
  
Alternatively, the IP address of the drive may be changed to suit the settings of the PC network adapter. The 
IP address of the drive can be configured using the DCT function, accessible from within DSE Lite by selecting 
Command -> Install AC15/AC20 Firmware.  
 

 
 
Once the network scan is completed, then the drive settings can be edited.  
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If the drive is not found by DSE lite, or a new drive is connected to the Ethernet port, a network scan must be 
performed again, as blow. 
 

 
  
Once the network scan has been performed, any AC20 connected to the network will appear and DSE lite 
can connect to the drive. 

 
 
When connected to a drive, this is shown in the scratch pad.      
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APPENDIX D: Object directory (CANopen over EtherCAT) 
Standard 
The standard object dictionary is implemented according to the DS301 communication profile. Note that 
certain object entries correspond to settings in the EtherCAT Object (F5h), and the Diagnostic Object (02h). 
 

Index  Object Name  Sub-Index  Description  Type  Access Note 

1000h  Device Type  00h  Device Type  U32  RO EtherCAT Object 

1001h  Error Register  00h  Error Register  U8  RO 

Diagnostic Object 1003h  Pre-define error 
field  

00h  Number of 
errors  

U8  RW 

01h..06h  Error field  U32  RO 

1008h  Manufacturer 
device name  

00h  Manufacturer 
device name  

Visible 
string  

RO 

EtherCAT Object 
1009h  Manufacturer 

hardware version  
00h  Manufacturer 

hardware 
version  

Visible 
string  

RO 

100Ah Manufacturer 
software version 

00h Manufacturer 
software 
version 

Visible 
string 

RO 

1011h  Restore 
parameters  

00h  Largest sub 
index 
supported  

U8  RO 01h 

01h  Restore all 
default 
parameters  

U32  
 

RW 
 

- 

1018h  Identify object  00h  Number of 
entries  

U8  
 

RO 
 

Number of entries 

01h  Vendor ID  U32  RO 

EtherCAT Object 

02h  Product Code  U32  RO 

03h  Revision 
Number  

U32  RO 

04h  Serial Number  U32  RO 

1600h – 
1xxxh  
  

Receive  
PDO mapping  

00h  No. of mapped 
application 
objects in PDO  

U8  RO/RW 0..254 

01h  Mapped object 
#1  

U32  
 

RO/RW 
 

- 

…  …  …  … - 
NNh  Mapped object 

#NN  
U32  
 

RO/RW 
 
 

- 
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Index  Object Name  Sub-Index  Description  Type  Access Note 

1A00h – 
1xxxh  
 

Transmit PDO 
mapping 

00h No. of mapped 
application 
objects in PDO 

U8 RO/RW 0..254 

01h Mapped object 
#1 

U32 RO/RW - 

… … … … … 

NNh Mapped object 
#NN 

U32  
 

RO/RW - 

1C00h Sync Manager 
Communication 
Type 

00h Number of 
entries 

U8 RO 4 

01h Mailbox wr U8 RO 1 

  02h Mailbox rd U8 RO 2 

  03h Process Data 
Out 

U8 RO 3 

  04h Process Data 
In 

U8 RO 4 

1C12h Sync Manager Rx 
PDO Assign 

00h No. of 
assigned 
PDOs 

U8 RO/RW Only writable in 
PREOP device state 

01h-NNh Assigned PDO U16 RO/RW 

1C13h Sync Manager Tx 
PDO Assign 

00h No. of 
assigned 
PDOs 

U8 RO/RW Only writable in 
PREOP device state 

01h-NNh Assigned PDO U16 RO/RW 
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Index  Object Name  Sub-Index  Description  Type  Access Note 

1C32h Output 
SyncManager 
Parameter 

00h Number of 
entries 

U8 RO 12 (0Bh) 

01h Synchronization 
Type 

U16 RO/RW 00h: Free Run 
02h: DC Sync0  

02h Cycle Time U32 RW Cycle time in 
nanoseconds 

03h Shift Time U32 RW Shift time in 
nanoseconds 

04h Synchronization 
Types 
supported 

U16 RO Bit 0 set: 
FREE_RUN 
supported  
Bit 2 set: DC Sync0 
Supported. 
Bit 5 set: Output shift 
with local timer All 
other bits are set to 
0 
 

05h Minimum Cycle 
Time 

U32 RO Minimum cycle time in 
nanoseconds. 

06h Calc and Copy 
Time 

U32 RO Output Calc and Copy 
Time in nanoseconds. 

09h Delay Time U32 RO Delay time in 
nanonseconds. 
Always set to 0. 

0Ch Cycle Time Too 
Small 

U16 RO Cycle time to small 

1C33h Input 
SyncManager 
Parameter 

00h Number of 
entries 

U8 RO 12 (0Bh) 

01h Synchronization 
Type 

U16 RO/RW 00h: Free Run 
02h: DC Sync0  

02h Cycle Time U32 RO Cycle time in 
nanoseconds. 

03h Shift Time U32 RW Shift time in 
nanoseconds. 

04h Synchronization 
Types 
supported 

U16 RO Bit 0 set: 
FREE_RUN 
supported Bit 2 set: 
DC Sync0 
supported. 
Bit 5 set: Input shift 
with local timer All 
other bits are set to 
0 
 

05h Minimum Cycle 
Time 

U32 RO Minimum cycle time in 
nanoseconds,  

06h Input Calc and 
Copy Time 

U32 RO Input Calc and Copy 
Time in nanoseconds. 

0Ch Cycle Time Too 
Small 

U16 RO Cycle time to small,  
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Manufacturer Specific Objects 
The exact representation of a parameter depends on its number of elements. In the following example, 
Parameter no. 0002h and 0004h only contain one element each, causing them to be represented as simple 
variables rather than arrays. The other parameters have more than 1 element (of the same data type), 
causing them to be represented as arrays. If a parameter has more than 1 element of different data types, it 
will be represented as a record. 
The offset between the Parameter no. and the object index is always 2000h. 
 
Index Object Name Sub-Index Description Type Access 
2001h Parameter 

0001h 
00h Number of entries (NNh) U8 RO 
01h Parameter value  - - 
... 
... 
NNh 

2002h Parameter 
0002h 

00h Parameter value - - 

2003h Parameter 
0003h 

00h Number of entries (NNh) U8 RO 
01h Parameter value - - 
... 
... 
NNh 

2004h Parameter 
0004h 

00h Parameter value - - 

... ... ... ... ... ... 
5FFFh Parameter 

3FFFh 
00h Number of entries (NNh) U8 RO 
01h Parameter value - - 
... 
... 
NNh 
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